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Safety Information

Important Information

Read these instructions carefully and look at the equipment to become familiar with 

the device before trying to install, operate, service, or maintain it. The following 

special messages may appear throughout this manual or on the equipment to warn of 

potential hazards or to call attention to information that clarifies or simplifies a 

procedure.

The addition of either symbol to a “Danger” or “Warning” safety label 

indicates that an electrical hazard exists which will result in personal 

injury if the instructions are not followed.

This is the safety alert symbol. It is used to alert you to potential 

personal injury hazards. Obey all safety messages that follow this 

symbol to avoid possible injury or death.

W DANGER
DANGER indicates a hazardous situation which, if not avoided, will result in 
death or serious injury. 

W WARNING
WARNING indicates a hazardous situation which, if not avoided, could result in 
death or serious injury.

W CAUTION
CAUTION indicates a hazardous situation which, if not avoided, could result in 
minor or moderate injury.

NOTICE
NOTICE is used to address practices not related to physical injury.
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Safety Notes

1. This instrument is intended for industrial control applications within the 

requirements of the European directives on safety and EMC.

2. Installation may be carried out only by qualified personnel.

3. To prevent hands or metal tools coming into contact with parts that are electrically 

live the instrument must be installed in an enclosure.

4. Where conductive pollution (e.g. condensation, carbon dust) is likely, adequate 

air conditioning/filtering/sealing etc. must be installed in the enclosure.

5. The instrument is fitted with an over current protection device which is not user 

serviceable. If it is suspected that this has failed, the manufacturer’s local service 

centre should be contacted for advice.

6. Whenever it is likely that protection has been impaired, the unit shall be made 

inoperative, and secured against accidental operation. The manufacturer’s 

nearest service centre should be contacted for advice.

7. If the equipment is used in a manner not specified by the manufacturer, the 

protection provided by the equipment might be impaired.

8. The unit must be wired according to the instructions in this manual.

W WARNING
WARNING Any interruption of the protective conductor inside or outside the 
apparatus, or disconnection of the protective earth terminal is likely to make the 
apparatus dangerous under some fault conditions. Intentional interruption is 
prohibited. 

W WARNING
WARNING Live sensors: The unit is designed to operate if the temperature 
sensor is connected directly to an electrical heating element. It must be ensured 
that service personnel do not touch connections to such inputs whilst the inputs 
are live. With live sensors, all cables, connections and switches for connecting the 
sensor must be mains rated for use in 240 V Cat Ⅱ.

W WARNING
WARNING Grounding the temperature sensor shield: Where it is common 
practice to replace the temperature sensor whilst the instrument is live, it is 
recommended that the shield of the temperature sensor be grounded to a 
protective earth cable, as an additional protection against electric shock.

W WARNING
WARNING The instrument must not be wired to a three-phase supply with an 
unearthed star connection, because, under fault conditions, such a supply could 
rise above 240 V RMS with respect to ground, thus rendering the instrument 
unsafe.
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9. Before any other connection is made, the protective earth terminal shall be 

connected to a protective conductor. The mains (supply voltage) wiring must be 

terminated in such a way that, should it slip, the Earth wire would be the last wire 

to become disconnected. The protective earth terminal must remain connected 

(even if the equipment is isolated from the mains supply), if any of the I/O circuits 

are connected to hazardous voltages (A full definition of ‘Hazardous’ voltages 

appears under ‘Hazardous live’ in BS EN61010. Briefly, under normal operating 

conditions, hazardous voltages are defined as being > 30 V RMS (42.2 V peak) 

or > 60 V dc.)

The protective earth connection must always be the first to be connected and the 

last to be disconnected. 

Wiring must comply with all local wiring regulations, e.g. in the UK, the latest 

IEEE wiring regulations (BS7671) and in the USA, NEC class 1 wiring methods.

10. Signal and supply voltage wiring should be kept separate from one another. 

Where this is impractical, shielded cables should be used for the signal wiring.

11. The maximum continuous voltage applied between any of the following terminals 

must not exceed 240 V ac.

a. Relay output to logic, dc or sensor input connections.

b. Any connection to ground.

The ac supply must not be connected to sensor input or low-level inputs or 

outputs.

12. Over temperature protection: A separate over-temperature protection unit (with 

an independent temperature sensor) should be fitted to isolate any process 

heating circuit should a fault condition arise.

Alarm relays within the instrument do not give protection under all fault 

conditions.

13. In order to allow the power supply capacitors to discharge to a safe voltage, the 

supply must be disconnected at least two minutes before the instrument is 

removed from its sleeve. Touching exposed electronics in an instrument which 

has been removed from its sleeve should be avoided.

14. Instrument labels may be cleaned using isopropyl alcohol, or water or 

water-based products. A mild soap solution may be used to clean other exterior 

surfaces.

Equipment and personnel protection

1. The designer of any control scheme must consider the potential failure modes of 

control paths and, for certain critical control functions, provide a means to 

achieve a safe state during and after a path failure.

2. Separate or redundant control paths must be provided for critical control 

functions.

3. System control paths may include communication links. Consideration must be 

given to the implications of unanticipated transmission delays or failures of the 

link.

4. Each implementation of this equipment must be individually and thoroughly 

tested for proper operation before being placed into service.
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Safety requirements for permanently connected equipment state

1. A switch or circuit breaker shall be included in the building installation.

2. It shall be in close proximity to the equipment and within easy reach of the 

operator.

3. It shall be marked as the disconnecting device for the equipment.

4. Recommended external fuse ratings are: 2 A Type T 250 V.

Backup battery

1. This instrument is fitted with a battery designed to retain configuration and other 

data in the event of failure of the power supply to the instrument.

2. The battery has an expected life of > 1 year unpowered at nominal operating 

temperature of 25℃, but this may be reduced if the instrument is operated at 

elevated temperatures. Low battery indication must be programmed into the 

application by the designer.

3. The battery is not user serviceable.

USB device precautions

1. Precautions against electrostatic discharge should be taken when the instrument 

terminals are being accessed. The USB and Ethernet connections are 

particularly vulnerable.

2. Ideally, the USB device should be plugged directly into the instrument, as the use 

of extension leads may compromise the instrument’s ESD compliance. Where 

the instrument is being used in an electrically ‘noisy’ environment, however, it is 

recommended that the user brings the USB socket to the front of the panel using 

a short extension lead. This is because the USB may ‘lock up’ or reset in noisy 

environments and the only means of recovery is to remove the device, then 

re-insert it. For memory sticks, EMC-related failure during a write operation might 

cause corruption of the data held on the stick. For this reason, the data on the 

memory stick should be backed up before insertion and checked after removal.

3. When using a USB extension cable, a high quality screened cable must be used. 

The total length of USB cable between the device and the USB port must not 

exceed 3 metres (10 feet).

NOTICE
NOTICE The use of U3 USB Flash drives is not recommended.
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Symbols used on the instrument labelling
One or more of the symbols below may appear either as a part of the labelling of the 

items comprising this instrument. In some cases, symbols may be incorporated in the 

moulding or stamped on the metalwork.

Symbol Meaning

W Refer to the user guide for instructions.

5 Protective earth ground conductor terminal

O Precautions against electrostatic discharge must be taken before handling 
this unit or any electronic component of it.

s Complies with the RoHS2 (2011/65/EU) directive.

* For environmental reasons, this product must be recycled before its age 
exceeds the number of years shown in the circle.

X Underwriters Laboratories listed mark for the United States and Canada.

C This unit is CE compliant.

RCM. Regulatory Compliance Mark for Australia and New Zealand.

7 Ethernet connector.

T USB connector.

D Risk of electric shock.

Table 1: Symbols used on the E+PLC100
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Introduction

What’s in this User Guide

This document describes the installation of the E+PLC 100 hardware, an explanation 

of the default application and an introduction to CODESYS software. The instrument 

comes with four input channels as standard. It is equipped for secure archiving via 

FTP transfer and/or to USB memory stick.

Unpacking the instrument
The instrument is despatched in a special pack, designed to give adequate protection 

during transit. Should the outer box show signs of damage, it should be opened 

immediately, and the contents examined. If there is evidence of damage, the 

instrument should not be operated and the local representative contacted for 

instructions. After the instrument has been removed from its packing, the packing 

should be examined to ensure that all accessories and documentation have been 

removed. The packing should then be stored against future transport requirements.
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Installation

What’s in this section

This section gives details on the mechanical and electrical installation of the E+PLC 

100. 

Mechanical installation
See Figure 1 for installation details.

Installation Procedure

1. If it is not already in place, fit the sealing gasket behind the front bezel of the 

instrument.

2. Insert the instrument through the panel cutout, from the front of the panel.

3. Spring the retaining clips into place, and secure the instrument by holding it firmly 

in place whilst pushing both clips towards the rear face of the panel.

4. The protective membrane can now be removed from the display.

Figure 1 Securing the Instrument

W CAUTION
Before installation, ensure that the specified instrument supply voltage matches 
the facility supply.

Push springs  towards panel

Retaining spring (two places)

For the sake of clarity, the panel
is shown as though transparent
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Demounting

This section describes un-installation of the complete instrument including the 

sleeve.

1. Isolate the mains supply and secure it against accidental operation. Remove all 

wiring and the USB device and Ethernet cable (if any). 

2. Remove the retaining springs by unhooking them from the sides using a small 

flat-blade screwdriver.

3. Pull the instrument forwards out of the panel.

Removing the Instrument from its Sleeve

The instrument is designed to be removed from its sleeve from the front panel. 

However, if a USB memory stick or the Ethernet cable is fitted then this must be 

removed first. 

When the instrument is shipped from the factory it is fitted with two small red clips, 

one in the top side of the sleeve and the other below. These are intended as a 

safeguard against removal of the instrument from its sleeve when an Ethernet cable 

is fitted. These clips must also be removed, using a small screwdriver, before the 

instrument can be taken out of its sleeve.

Ease the latching ears outwards (see illustration overleaf) and pull the controller 

forward.

When plugging back in ensure that the latching ears click into place to maintain the 

panel sealing.

W WARNING
Before removing the supply voltage wiring, isolate the supply voltage and secure it 
against unintended operation.
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Dimensions and Panel Cut Out

Figure 2: Mechanical installation details

 Electrical installation
The illustration overleaf shows the locations of the various user terminations along 

with signal and supply wiring pin-outs.

 Termination details

The screw terminals accept single wires in the range 0.21 to 2.08 mm2 (24 to 14 

AWG) inclusive, or two wires each in the range 0.21 to 1.31 mm2 (24 to 16 AWG) 

inclusive.

Panel cutout:

92  mm × 92  mm (both −0 +0.8  mm)

3.62  in × 3.62  in (both −0.00 +0.03 in)

Minimum inter-unit spacing:

Horizontal (‘x’) = 10 mm (0.4 in)

Vertical (‘y’) = 38 mm (1.5 in)

Side View

Top View

Latching 
ears
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Screw terminals should be tightened to a torque between 0.4  N⋅m (3.54 lb⋅in) and 

0.5  N⋅m (4.43 lb⋅in)

Figure 3: Connector locations and pin-outs (rear panel)

− −

−

−

− − − − −

−

4−

3−

2−

1−

For thermocouples use the correct type of compensating cable and maintain polarity throughout.
For milliamp input, this must be configured as a voltage input with an ohms law calculation in the strategy to convert to current. 
For other connections use conductors only.
The power supply input is not fuse protected. This should be provided externally

Each wire connect-
ed to LA, LB and LC
must be less than 10
metres in length.

Opt1

Isolated DC o/p (mA)

Opt2
Contact closure

Ohms inputs

20.4 to 28.8 Vac;
48 to 62 Hz or

19.2 to 26.4 V dc
(polarity irrele-

vant)

100 to 230 Vac 
±15%;

50/60 Hz

R>500R = inactive 
R<150R = active 

O/P4;  O/P5

R> 600R = inactive
R< 300R = active

Internal Link (0 V)

Mains (Line) supply voltage wiring

Supply
Voltage

Brown

Blue

Opt3 Dig InA

Isolated DC o/p (mA)

Low voltage option supply voltage wiring

Logic o/p (active high)

Logic o/p (active high)

mV
0 to 1V
0 to 10V

T/C

1R0≤R≤1k0 

Protective 

Dig InB

Contact closureRelay output
An In 1; An In 2; An In 3; An In 4

Relay outputIsolated DC o/p (mA/ V)

T/C, Volts, millivolts RTD (two wire)RTD (three wire)Milliamps

Contact closure

earth ground
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 Low Voltage Option

This option allows the use of a low voltage ac or dc 24 V supply. The "Technical 

Specification" on page 43 gives full details. The polarity of the dc supply connection is 

not important—it may be connected either way round.
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Operation

What’s in this chapter

This chapter provides an overview of how to operate the E+PLC 100, using the 

Default Application as an example.

Start up
When the instrument is initialising a 

splash screen is displayed. 

This is followed by a white screen for up to 

10 seconds, followed by the visualisation 

that forms part of the CODESYS 

application. 

New instruments are pre-loaded with a 

default application which may be used to 

provide an introduction to the instrument 

features and a method of setting the 

network configuration and time/date.

The first time you connect to the instrument using the E+PLC software (CODESYS 

Development System) you will have to enter an Administrator password for the 

device.

Note:  Ensure the strong password you create can be memorized and entered 

correctly, as the device will be inaccessible and remain non-connectible without the 

Administrator password.

For further information see;

• "Accessing the CODESYS Online Help" on page 39

• CODESYS Online Help > Home > Setting up E+PLC100 hardware > Initial 

connection & connecting to E+PLC100

NOTICE
A typical start up time for the instrument is about 90 seconds. Large applications 
may take longer to load but the majority (90–95%) of the typical start up time is for 
instrument initialisation.

W WARNING
LIVE SENSORS

The default application must be removed when the user application is installed. 
Removing an application does NOT default the network settings, nor the 
time/date. Therefore, if users do not require these to be changed again, then the 
user application does not have to include mechanisms to change them. If, 
however, network settings, and time/date may need to be changed in the future, 
the user application must include a method of setting them. When removing an 
application please refer to "Configure" on page 23 for instructions. 
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Introduction to the Default Application

The default application opens a ‘home’ screen 

which provides navigation to four page 

headers via the f1 to f4 touch sensitive 

buttons.

The default application is available from the 

E+PLC installed location, typically 

C:\Program 
Files(x86)\Eurotherm\E+PLC"Version NN"\E+PLC100\DefaultApplica
tion.

f1 = demo.  This allows access to a simple demonstration application.

f2 = configure.  This allows IP addresses and time and date settings to be 

configured. 

f3 = help.  This selects a help page. 

f4 = status.  This shows the state of analogue and digital I/O.  

Note:  f1 to f4 have different functions when other pages have been selected—

generally as follows:

f1  Return to home page

f2  Continuous scroll around the four header pages.

f3  ‘back’ function

f4  ‘forward’ function

Please refer to the section "Navigation Diagram" on page 21.
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Navigation Diagram

The function buttons are used to navigate around the display as shown in the 

diagram below:-
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Demo

This page shows a mimic of a hypothetical 

vacuum furnace which performs a simple 

ramp/dwell temperature sequence.

The two temperature zones follow a ramp up, 

dwell and ramp down sequence with events 

occurring at specific times. These events are 

displayed in the message boxes as the 

sequence progresses.

Features 
Press f4 ‘forward’ to display a list of features followed by those in current devel-
opment

.
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Configure

Configuration pages allow the network settings and time/date to be set up. 

Setting the IP address

Click into the IP address to set. The ‘number’ pad appears. Enter the required 

address and ‘accept’. 

‘escape’ closes the number pad and ‘clear’ returns to the previously entered address

The same procedure is followed for the Subnet Mask and Default Gateway.

Please refer to the Warning note on page 19 if the demonstration is removed and 

replaced by the user program. 

Also from this page access to further methods of setting the address is possible:-

• DHCP

• DNS

• MAC address. This is read only

NOTICE
The addresses cannot be changed if a contact is made between terminals LA and 
LC (Dig In 1). This is to protect against unauthorised changes.
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Setting the time and date

From the configuration page, press f4 

(forward)

Click into the setting to access the number 

pad and enter the correct time followed by 

date.
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Help Pages

The ‘help’ page provides access to a number of screens as shown below:

HOME Page

main page starting CODESYS

project page reset page
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Status Page 

This page shows the status of the I/O. The 

first page shows the status of the analogue 

and digital inputs.

The Digital Input 1 indicator can be turned on 

by closing the contact on terminals LA and LC 

(Dig In A).

The Digital Input 2 indicator can be turned on 

by closing the contact on terminals LB and LC 

(Dig In B).

Press ‘forward’ to show the status of the relay 

outputs. To change the state of the relays 

touch the relevant button on the screen. 
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To Configure E+PLC 100 Input/Output

What’s in this section

This section explains how to use the CODESYS Integrated Development 

Environment to configure the E+PLC 100 I/IO.

The E+PLC100 is configured and monitored using the E+PLC software which 

includes the CODESYS Development System, running on a PC (Windows 8 / 10, 

32/64 Bit. The versions maintained by Microsoft are supported).

Connect to a Device
Connect the E+PLC100 to a PC running the CODESYS software using the Ethernet 

connection. For further information see;

• "Accessing the CODESYS Online Help" on page 39

• CODESYS Online Help > Home > Setting up E+PLC100 hardware > Initial 

connection & connecting to E+PLC100

• ‘How to’ videos. These can be accessed through the web portal on the Start page 

displayed when CODESYS is first launched.

1. Open the CODESYS software

If the ‘CODESYS Guides’ section is not shown when first opened, select View > Start 

Page. 

In the section Latest News a list of sample applications may be found.
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2. New Project: Select New Project and give it a name, e.g. Application1.

3. Select E+PLC100 project

There is more than one way to define the I/O, but the most convenient may be to 

show it graphically using a view of the rear terminals. 
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4. Double click Backplane (Local IO)

A view of the terminal block is shown. Click in any of the grey selection boxes to show 

a list of available input or output types. The list of available I/O is opened under the 

Backplane folder. 

To select Analogue Input type

Right click into the grey selection box next to the input to be configured, for example, 

the 1I, 1+, 1− terminals (Input 1). 

Select the input type 

from: 

• Off

• −40mV to +40mV

• −80mV to +80mV

• −3V to +10V

• −2V to +2V

• 3-Wire, 0 to 400 Ω 

(Platinum 

resistance 

thermometer, PRT)

• Thermocouple −40mV to +40mV

• Thermocouple −80mV to +80mV

Repeat for all four inputs.
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A diagrammatic representation of the I/O type is shown connected to the relevant 

terminal. Note that terminals with an I suffix (capital letter ‘i’) act as a current source 

for resistance measurements. In the example shown:

• Input 1 is a thermocouple/

• Input 2 is mV or V.

• Input 3 is configured as a 3-wire RTD. The physical input can be a 2-wire RTD by 

wiring it between 3I and 3+ with a link placed between 3+ and 3−.

• Input 4 is a 3-wire PRT.

To select Option I/O type 

Click in the grey selection box next to the option I/O terminals. The choices are:

OptionIO (DDD) Choose this option if the hardware of your device contains:         

Isolated DC O/P on Opt1, Opt2 and 
Opt3

OptionIO (LLR) Choose this option if the hardware of your device contains:     

Opt1 = Logic input or output; Opt2 = Logic output only; 

Opt3 = normally open relay
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Plug Device This option in 
E+PLC100 is in-
cluded for future 
development. In 
this release the 
above options are 
duplicated.  

FixedDIO Not applicable to the current release 

Fixed_AI4 Not applicable to the current release 

Module Configuration Tab

Double click the path ‘Fixed_AI4’. In the tab ‘Module Configuration’ a list of the 

analogue I/O is given.

The I/O can also be configured from this menu as an alternative to the backplane 

view
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Module I/O Mapping Tab

The tab Module I/O Mapping shows the parameters associated with the I/O type. It 

also allows the source of the parameter to be defined. For example, to wire the 

container to physical input, double click in the Variable column of the MV1 line. 

Provided that an application has been created (i.e. an input or output container has 

been defined as explained in "Wiring" on page 35.) then, using the ellipsis, find the 

variable you want and double click. The name of the POU will be displayed as shown 

below. 

Similarly, double click the path ‘FixedDIO’ to show the Module Configuration of the 

Fixed IO.
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Or ‘OptionIO’ to show the Module Configuration of the variable IO
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Introduction to Producing a Strategy
This section is intended as a very basic introduction to produce a real application. 

Double click the tab ‘PLC_PRG’.

Example: To produce a ‘container’ for analogue input 1.

Drag an ‘Input’ from the ToolBox on the right hand side. This box is a container for a 

variable. 

Type in a name e.g. Input1. 

When enter is pressed the Auto Declare pop up is displayed.

Select the Type from the drop down. In this example the type is a REAL value.

The flags CONSTANT, RETAIN and PERSISTANT are defined in the CODESYS 

Help. Note that RETAIN and PERSISTANT data is stored in an FRAM device, 

periodically (typically every 10 s).

When the block has been entered it will appear under the VAR list.
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Wiring

Example: To connect the Input to an Output container so that its value appears in the 

output container.

Drag and drop an ‘Output’ from the ToolBox and configure it in the same way as 

shown for Input1.

Click on either the input or output and drag a wire from one to the other.

To Add a PID Control Block

A further strategy can be built using the items from the ToolBox.

The ToolBox contains a list of commonly used function blocks.

If the required block is not present it can be added from the library. For example, to 

add a control block, select Library Manager from the list. Click Add library and 

Select EPLC Control and OK.
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Example 1: To wire Input1 to the PID loop

Drag a ‘Box’ from the ToolBox. Name the box eg PID — a drop down is shown when 

you begin typing. When the block is declared it will appear in the VAR list.

Add a wire from the output of ‘Input1’ to the applicable input parameter of the PID 

block, e.g. the PV input ‘rPV’.

Note the prefix:

r means a reference source.

x is a boolean

e is an enumeration

rr is a reference source the value of which can be overridden depending upon 

the strategy. For example, a three term value may be overridden by auto tune

When complete select Build from the menu.

Further information is available by accessing the Help library.

NOTICE
To reduce the number of I/O parameters, right click the block, select Pins and 
Remove Unused pins.
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Example 2: Touch Screen Lock

A function block specific to E+PLC100 allows the touch screen to be locked. The 

strategy shown in the screen shot below shows the touch screen locked by a digital 

input being activated. The strategy could be expanded using inputs such as a timer to 

start a timed delay, for example.

A confirmation of the lock is produced by the function block TouchScreenLocked 

shown below connected to a digital output but which could equally produce a screen 

message or other functions. 

To produce the TouchScreenLock function block, Drag a ‘Box’ to the screen.  Begin to 

type ‘E_SL’ (Eurotherm Screen Lock) and select this from the pop up. Then begin to 

type ‘.’ and select ‘TouchScreenLock’.

The ‘TouchScreenLocked’ confirmation function block is similarly produced.

These blocks are shown wired to Input and Output blocks as in the previous 

example.

Alternatively, it may be found more convenient to add the EPLC Screen Lock library 

from the Library Manager. The procedure is described in "To Add a PID Control 

Block" on page 35.
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Loading a new application

What’s in this section

This section explains how to load a new application onto the E+PLC 100

As stated in "Operation" on page 19 it is necessary to clear the demonstration or any 

other application before loading a new one. The method for doing this is to perform a 

‘Reset origin device’ operation in the CODESYS software. This is accessed from 

the CODESYS Development System file manager.

For further information see;

• "Accessing the CODESYS Online Help" on page 32

• CODESYS Online Help > Home > General Topics > Recovery Procedures

• CODESYS Online Help > Home > General Topics > Recovery Procedures > 

Restore non-responsive Device.

This will remove all application specific files, including the visualisation images. 

NOTICE
In the current release it is not possible to access the application files via the 
CODESYS Development System file manager.
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Accessing the CODESYS Online Help

What’s in this section

This section explains how to access the help in the CODESYS Integrated 

Development Environment.

Online Help
The CODESYS software includes extensive online help.

To launch the CODESYS help, click on its Help menu:

The Online Help window is displayed.



Accessing the CODESYS Online Help E+PLC 100

40 HA032001 Issue 10

CODESYS Library Documentation
In addition to the CODESYS Online help, CODESYS libraries include their own 

documentation, with detailed information on the POUs (Program Organisation Units) 

in the library (such as functions and function blocks). These can be viewed in the 

CODESYS editor windows themselves, for example, in the Library Manager shown 

below.

A subset of the same information is also displayed in a tooltip when using the mouse 

to hover over POU.

To display information on a POU in the Online Help window, select the POU and 

press F1.
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Online tutorials and ‘How to’ videos

A range of online tutorials and ‘How to’ videos for the E+PLC 100 are available. 

These can be accessed through the web portal on the Start page displayed when 

CODESYS is first launched.

Additional Notes

Modbus Communications - Setting up projects for Modbus

NOTICE
To access the online tutorials, the PC running the CODESYS software must have 
internet access.

Eurotherm 
web portal

NOTICE
To enable Modbus slave communications on an E+PLC device, you must 
uncomment the line:

pass in on emac0 proto tcp from any to any port = 502

In the firewall configuration file which can be found on the device’s file-system at 
/Firewall/fw4.cfg and can be restricted to specific IP or MAC addresses. 
Changes to the firewall will not take effect until the instrument is power-cycled.
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Encrypted Communications

WebVisu - Security Requirements

Eurotherm Visualization Extension

Firmware update - Modbus slave settings

W CAUTION
Encrypted Comms (communications), which is set to ON by default (for phase 4) 
should be used and remain ON to help provide additional security through the use 
of encryption and minimize exploitation of known common vulnerabilities

W CAUTION
When using the WebVisu functionality on the E+PLC device, ensure both security 
methods User Authentication and Https are used.

NOTICE
The CODESYS HMI software package does not support some Eurotherm 
visualization components and will not display them correctly. Therefore it is not 
recommended to use the Eurotherm visualization library components with the 
CODESYS HMI software package.

W CAUTION
When applying a Firmware update to an E+PLC device using a Modbus slave 
function, it possible that the serial port settings may be cleared.
Before commencing any update it is recommended that both the project should be 
backed up and any Modbus slave settings recorded.
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Technical Specification

What’s in this section

For reference purposes, this section lists technical specifications for the E+PLC 100.

General

I/O types 
Analogue inputs Four

Digital inputs Three maximum (dependent on option board)

Digital (logic) outputs: Two maximum (dependent on option board)

Relay outputs: Three maximum (dependent on option board)

DC outputs: Two maximum (dependent on option board)

Network communications
Ethernet: 10/100 BASE-T Ethernet (IEEE802.3)

Protocols: Modbus TCP/IP master/slave

Cable type: Category 5

Maximum length: 100 metres (110 yards)

Termination: RJ45

LEDs: Green LED illuminated = link connected;
Amber LED flashing shows link activity

USB
Number of ports: one at rear of instrument

Standard: USB 1.1

Transmission speeds: 1.5 Mbits/s (low speed device)

Maximum current: < 100 mA

Peripherals supported: Memory stick (8 GB max.), barcode scanner (US 
locale only), keyboard (US layout only)

HMI
Display: 3.5″ TFT colour display (320 pixels wide × 240 pixels high), 

active touch screen size 320 × 288 pixels—refer to "Dis-
play and Active Touchscreen Dimensions" on page 51.

Controls: Projected capacitive touchscreen; webserver

Memory resources
Application/visualisation files: 12 MB

Data Recording history files: 22 MB

Retain/Persistent data: 62 kB

File system
Max. filename length: 125 Unicode (UCS 16) characters
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Data Recording update/archiving
Sample rate (input/output): 8 Hz

Trend update: 10 Hz max.

Archive sample value: Latest value at archive time

Display value: Latest value at display update time

Real time clock (RTC) battery
Stored data: Time, date

Replacement period: Three years typical

Support time: Minimum of 1 year with unit unpowered

Temperature stability: 0 to 55 ℃ ≤ +3.5ppm

RTC ageing: First year to 10 year < ± 5ppm

Type: Lithium polycarbonmonofluoride, Eurotherm part
number PA260195

Integrated Development Environment (IDE)
Software: CODESYS IDE v3.5 with E+PLC packages

Power specifications
Supply voltage: Standard 100 to 230 V ac ±15% at 48 to 62 Hz

Low voltage: 24 V ac (+10% −15%) at 48 to 62 Hz, 
 or 24 V dc (+20% −15%)

Power dissipation: 9 W max.

Fuse type: No internal fuse fitted.

Interrupt protection: Standard: Hold-up > 20 ms at 85 V RMS supply voltage

Low voltage: Hold-up > 20 ms at 20.4 V RMS supply voltage

Environmental specifications
Ambient temperature range:

Operating: 0 to 55℃
Storage: −20 to +70℃. 

Max. rate of change 1℃/min

Humidity range: Operating: 5% to 85% RH non-condensing

Storage: 5% to 85% RH non-condensing

Protection: Front Panel: IP66, NEMA12

Rear Panel: IP10 (International)

Shock/vibration: To BS EN61131-2: section 4.2.1 (5 to 150 Hz. at 2 g; 
0.5 octave per min.)

Altitude: < 2000 metres

Atmosphere: Not suitable for use in explosive or corrosive atmospheres.

W CAUTION
RTC BATTERY: RISK OF EXPLOSION

Do not recharge, disassemble or dispose of the battery in fire. 

Mistreating the battery in this way may cause it to explode.
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Electromagnetic compatibility
Emissions: Standard units: BS EN61326 Class B—Light industrial

Low voltage option:BS EN61326 Class A—Heavy industrial

Immunity: BS EN61326 Industrial

Other approvals and compliance details
Regional: Europe: CE, RoHS, REACH, WEEE

USA, Canada: UL, cUL

Russia: EAC and Metrological Pattern Approval

China: RoHS. Not subject to CCC.

Industry-specific: Nadcap: suitable for use in furnace classes A–E
as per AMS 2750E Section 3.

Packaging: BS 61131-2:2007—Section 6.3.3 / 6.3.4.

Electrical safety: BS EN61010-1 (Installation category Ⅱ; Pollution degree 2)

Physical
Panel mounting: ¼ DIN

Weight: 0.44 kg (15.52 ozs) (instrument only)

Panel cut-out dimensions: 92 × 92 mm (both −0.0 +0.8) or 3.62 × 3.62″ (both 
−0.00 +0.03″)

Depth behind panel: 90 mm (3.54″) excluding wiring
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Fixed I/O

Analogue Inputs (An In 1–4)

General
Number of inputs: Four

Input types: dc volts, dc mV, dc mA, linear ohms, thermocouple, RTD 
(2-wire and 3-wire)

Input type mix: freely configurable

Sample rate: 8 Hz (125 ms)

Conversion method: 16 bit delta sigma

Input ranges: See Table 1 (dc volts, dc mV) 

Mains rejection (48 to 62 Hz):

Series mode: > 95 dB

Common mode: >179 dB

Voltage: Series mode: 280 mV at lowest range; 5 V 
peak to peak at highest range

Common mode: 250 V ac max.

Input impedance: 40 mV, 80 mV, 2 V ranges: > 100 MΩ

10 V range: input voltages > 5.6 V: 62.5 kΩ

input voltages < 5.6 V: 667 kΩ

Overvoltage protection:

Continuous: ± 30 V RMS

Transient (< 1 ms): ± 200 V pk–pk between terminals

Sensor break detection:

Type: ac sensor break on each input giving quick 
response with no associated dc deviations

Recognition time: < 3 seconds

Minimum break resistance:

40 mV & 80 mV ranges: 5 kΩ

other ranges: 12.5 kΩ

Isolation:

Channel to channel: 300 V RMS or dc 
(double insulation)

Channel to common electronics: 300 V RMS or dc 
(double insulation)

Channel to ground: 300 V RMS or dc 
(single insulation)

Dielectric strength: Test: BS EN61010, 1 minute type test

Channel to channel: 2500 V ac

Channel to ground: 1500 V ac

Table 1: An In 1–4 Voltage Input Ranges

Low Range High Range Resolution Calibration accuracy 
(Instrument at 25℃)

Temperature Performance

−40 mV +40 mV 1.9 μV 4.6 μV + 0.053% of reading 13 ppm of input per ℃

−80 mV +80 mV 3.2 μV 7.5 μV + 0.052% of reading 13 ppm of input per ℃

−2 V +2 V 82 μV 420 μV + 0.044% of reading 13 ppm of input per ℃

−3 V +10 V 500 μV 1.5 mV + 0.063% of reading 45 ppm of input per ℃
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Current (dc mA)
Range: 0 to 20 mA

Shunt: 1 Ω to 1 kΩ mounted externally

Additional deviation due to shunt: 0.1% of input (for 2.49 Ω shunt)

Resistance (ohms)
Range: 0 to 400 Ω (resolution 20 mΩ)

Calibration accuracy (at 25℃): 120 mΩ + 0.023% of reading

Temperature performance: 25 ppm of input per ℃

RTD (2-wire and 3-wire)
Temperature scale: ITS 90

Maximum source current: 200 μA 

Range: 0 to 400 Ω (−200 to +850℃)—see Table 2

Resolution: 0.05 ℃
Calibration accuracy: ± 0.31℃ ± 0.023% of measurement in ℃

at 25℃ ambient

Temperature coefficient: ± 0.01℃/℃ ± 25ppm/℃ measurement in ℃
from 25℃ ambient

Electrical noise: 0.05℃ peak–peak with τ = 1.6 s input filter

Linearisation accuracy: 0.0033% (best fit straight line)

Lead resistance: 0 to 22 Ω matched lead resistances

Bulb current: 200 μA nominal

Table 2: RTD type details

RTD Type Overall range (℃) Standard Max. linearisation

Cu10   −20 to +400 General Electric Co. 0.02℃

Cu53   −70 to +200 RC21-4-1966 0.01℃

JPT100 −220 to +630 JIS C1604:1989 0.01℃

Ni100   −60 to +250 DIN43760:1987 0.01℃

Ni120   −50 to +170 DIN43760:1987 0.01℃

Pt100 −200 to +850 IEC751 0.01℃

Pt100A −200 to +600 Eurotherm Recorders SA 0.09℃
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Thermocouple
Temperature scale: ITS 90

Types, ranges and accuracies: See Table 3

CJC: Types: Off, internal, external, remote

Remote source: Any input channel

Internal accuracy: < 1℃ max. with instrument at 25℃
Internal rejection ratio: 40:1 from 25℃
Upscale/downscale drive:High, low or none, independently 

configurable for each channel’s 
sensor break detection

Digital Inputs (Dig In A and Dig In B)
Type: Contact closure

Short circuit sensing current (source): 5.5 mA (min.) to 6.5 mA (max.)

Open circuit (inactive) resistance: > 600 Ω

Closed circuit (active) resistance: < 300 Ω

Relay Outputs (O/P4 and O/P5)
Type: Form A (normally open)

Contact switching power (resistive): 1 A max. at 240 V RMS ±15%, 
5 mA min. at 5 V

Current through terminals: 1 A

Isolation: 300 V RMS or dc, double insulated 
from processor/comms. electronics

Table 3: An In 1–4 Thermocouple types, ranges and accuracies

Thermocouple type Range (℃) Standard Linearisation accuracy

B      0 to +1820 IEC584.1 0 to 400℃ = 1.7℃
400 to 1820℃ = 0.03℃

C         0 to +2300 Hoskins 0.12℃
D        0 to +2495 Hoskins 0.08℃
E  −270 to +1000 IEC584.1 0.03℃

G2         0 to + 2315 Hoskins 0.07℃
J  −210 to +1200 IEC584.1 0.02℃
K  −270 to +1372 IEC584.1 0.04℃
L −200 to +900 DIN43710:1985 (to IPTS68) 0.02℃
N  −270 to +1300 IEC584.1 0.04℃
R    −50 to +1768 IEC584.1 0.04℃
S   −50 to +1768 IEC584.1 0.04℃
T −270 to +400 IEC584.1 0.02℃
U −200 to +600 DIN43710:1985 0.08℃

NiMo / NiCo   −50 to +1410 ASTM E1751-95 0.06℃
Platinel       0 to +1370 Engelhard 0.02℃

Mi / NiMo       0 to +1406 Ipsen 0.14℃
Pt20%Rh / Pt40%Rh       0 to +1888 ASTM E1751-95 0.07℃
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Optional I/O
Channel positions Opt1, Opt2 and opt3 can either be fitted with an LLR board (logic, 

logic, relay) or a DDD board (dc output, dc output, dc output).

LLR Board

Logic input (Opt1 only)
Type: Active (current on) contact closure sourcing

Input current: Input at 12 V: 0 mA min. to 44 mA max

Input at 0 V: 6 mA (steady state) to 
44 mA (switch current)

Open circuit input voltage: +11 V to +13 V

Open circuit (inactive) resistance: > 500 Ω

Closed circuit (active) resistance: > 150 Ω

Logic outputs (Opt1 and/or Opt2)
Type: Active (current on) current sourcing, or Inactive (current 

off) current sourcing

Voltage output across terminals: Active: +11 V to +13 V

Inactive: 0 V to +300 mV

Short circuit output current (active type): 6 mA (steady state) 
to 44 mA (switch current)

Output source leakage current into 

short circuit (inactive type):  0 μA to 100 μA 

Relay (Opt3 only)
Type: Form A (normally open)

Contact switching power (resistive): 2 A max. at 240 V RMS ±15%

100 mA min. at 12 V

Current through terminals: 2 A

Isolation: 300 V RMS or dc; double insulated 
from processor/comms. electronics
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DDD Board

mA current outputs (Opt1, Opt2 and Opt3)
Output range: Configurable within 0 to 20 mA

Load resistance: 500 Ω max.

Calibration accuracy:< ±100 μA ±1% of reading

Resolution: > 11 bits

Thermal drift: < 100 ppm/℃
Isolation: 300 V RMS or dc; double insulated from processor/comms 

electronics

Voltage output (Opt3 only)
Output range: Configurable within 0 to 10 V dc

Load resistance: 500 Ω min.

Calibration accuracy:< ±50 mV ±1% of reading

Resolution: > 11 bits

Thermal drift: < 100 ppm/℃
Isolation: 300 V RMS or dc; double insulated from processor/comms 

electronics
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Display and Active Touchscreen Dimensions

What’s in this section

This section shows the dimensions in pixels for the active touch screen area. It 

includes the display area and the button positions.

The size of the image and, therefore, the size that the visualisation is to be set is 320 

× 288 pixels. 

The button size and their positions from the top left hand corner are shown in the 

table below:

A touch in the same location for more than 10 seconds will be filtered out. 

It is recommended that the active elements are greater in size than the actual 

function keys.

The faceplate image is available from the E+PLC installed location, typically: 

C:\Program Files (x86)\Eurotherm\E+PLC\E+PLC100\Images.

Button

Size: 48 × 32 pixels

x y

f1 1 255

f2 91 255

f3 182 255

f4 271 255
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Hints and Tips

What’s in this section

This section provides a place to document miscellaneous useful information.

Recovery from excessive CPU loading
It is possible for an application to be developed that consumes all available CPU 

bandwidth which would prevent other lower priority tasks from running, this could 

include the network task resulting in the loss of network connection or not being able 

to make a network connection. To recover from this situation with a project that has 

been loaded and is running which contains such a task, but a boot application has not 

been created, simply power-cycle the device as the application is not retained. 

However, to recover from this situation with a project that has been loaded and is 

running which contains such a task AND a boot application has been created, copy 

the files located in the E+PLC 100. Recovery directory (typically C:\Program Files 

(x86)\Eurotherm\E+PLC\E+PLC100\Recovery) onto the root of a USB memory 

stick, insert the memory stick into the E+PLC100 device and power-cycle – this will 

result in the removal of the offending application.

For further information see;

• "Accessing the CODESYS Online Help" on page 39

• CODESYS Online Help > Home  >  General Topics  >  Recovery Procedures  >  

Device reset (excessive CPU load)

Recovery from invalid/forgotten network settings
The network settings used by the E+PLC 100 are contained in a network.ini file 

stored in the /startup drive on the device. In the event of these network settings 

being invalid for the network, or being forgotten, a connection can be made using the 

network settings contained in a network.ini file located on the root of a connected 

USB memory stick. This would allow an application to be developed to modify the 

internally stored network.ini file with the correct network settings. It should be noted 

that when the USB memory stick is removed and the device power-cycled, the device 

will use the network settings from the internally stored network.ini file.

For further information see;

• "Accessing the CODESYS Online Help" on page 32

• CODESYS Online Help > Home  >  General Topics  >  Recovery Procedures  >  

Reset Device Network settings.
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Recovery in the event of a fully built up firewall
It is possible for a firewall rule file to be created that blocks all incoming network 

traffic which would prevent the device ever being connected. If a device contains 

such a firewall configuration file, it is possible to open default network ports used by 

CODESYS by connecting a USB memory stick that contains a file called fw4.default 

in its root directory and power-cycling the device. It should be noted that when the 

USB memory stick is removed and the device power-cycled, the device will use the 

internally stored firewall rule file fw4.cfg (stored in the /startup drive). 

The default firewall permits the following:

• All TCP and UDP outbound traffic and their associated inbound responses 

(allowing Modbus master and FTP archiving communications)

• TCP and UDP inbound traffic from any port to port 53 (allowing DNS 

communications)

• ICMP traffic with rate limiting conditions (allowing PINGs and other Internet 

Control messages)

• UDP incoming traffic from any port to ports 1740 to 1743, and TCP incoming 

traffic from any port to port 11740 (allowing CODESYS IDE and gateway network 

scanner communications)

• UDP incoming traffic from any port to ports 1210, 1211, 1217 (allowing 

CODESYS gateway to PLC communications)

It should be noted that the default firewall does not permit the following, and 

additional firewall rules are required:

• Modbus slave communications (pass in on emac0 proto tcp from any to any port 

= 502)

• HTML communications (pass in on emac0 proto tcp from any to any port = 8080)

• SNTP communications (pass in on emac0 proto udp from any to any port = 123)

For further information see;

• "Accessing the CODESYS Online Help" on page 32

• CODESYS Online Help > Home  >  General Topics  >  Recovery Procedures  >  

Firewall reset.

Line Voltage Measurement for Power Feed Forward Control
The GetPSULineVoltage function from the ECmpPSU library can be utilised to get 

the line voltage for the E_CTRL.LOOP_RUNTIME.rVLine input.

Watchdog functionality
Hardware watchdog – The EE+PLC 100 Controller incorporates a hardware 

watchdog function that will trigger a device reset if an IO system health check fails.

For further information, refer to the CODESYS Help. 
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Ensure all images are downloaded
To ensure all images in an image pool are downloaded, verify that the 'Download only 

used images' attribute is unset as shown below:

NOTICE
E+PLC100 supports 24-bit bitmap images, however, they will be converted down 
to 16-bit bitmap images to be displayed on the target instrument and therefore 
image degradation may occur.
E+PLC100 does not support JPEG images on the target instrument in this 
release.
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